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1 Open Handset Alliance 5

LŠOHA est un consortium regroupant plus de 70 sociétés compre-
nant :
− des fabricants de terminaux Motorola, HTC, Dell, Garmin. . . ;
− des fabricants de composants Atheros, ARM, Gemalto, Broadcom,

Intel, NVIDIA. . .
− des opérateurs de téléphonie Bouygues Telecom, Vodaphone, . . . ;
− des sociétés de développement logiciel Google, . . . ;
− . . .

Motto

A commitment to openness, a shared vision for the future, and concrete plans to
make the vision a reality. To accelerate innovation in mobile and offer consumers
a richer, less expensive, and better mobile experience.
Together we have developed AndroidTM, the Ąrst complete, open, and free mobile
platform.
http://www.openhandsetalliance.com/oha_faq.html
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2 Android : matériel et logiciel combinés 6

− un document de référence exprime les contraintes matérielles nécessaires au support
de la pile logicielle ;
− un noyau Linux qui fournie les interfaces de bas-niveau vers le matériel, la gestion

de la mémoire, la gestion des processus, optimisé pour les appareils mobiles ;
− des bibliothèques opensource pour le développement dŠapplication incluant SQLite,

WebKit, OpenGL et un gestionnaire multimédia ;
− un logiciel de démarrage, runtime :
⋄ de petite taille, efficace pour une plateforme mobile
⋄ pour exécuter et héberger les applications Android ;
⋄ pour démarrer et gérer la machine virtuelle Dalvik ;
⋄ pour gérer et mettre à disposition les bibliothèque des fonctionnalités de base ;
− un ń framework ż qui expose tous les services à la couche applicative sans privilégier

une application suivant son origine (éditeur tiers ou non) : gestionnaire de fenêtre,
fournisseur de contenu, gestionnaire de position géographique, téléphonie et service
de communication p2p ;
− un ń framework ż dŠinterface utilisateur utilisé pour héberger et lancer les applis ;
− des applications pré-installées ;
− un kit de développement logiciel pour créer des applications : outils, plug-ins et

documentation.
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3 Les applications natives 7

Il existe un certain nombre dŠapplications disponibles dans Android :
− un client de messagerie compatible Gmail mais aussi avec dŠautres messageries ;
− une application de gestion des SMS ;
− un gestionnaire de contacts et dŠagenda, un PIM Personal Information Manage-

ment, intégré avec les services onlines de Google ;
− une application de gestion de ń Google Maps ż incluant StreetView, la navigation

guidée par GPS, les vues satellites et lŠobtention des conditions de traĄc ;
− un navigateur web basé sur WebKit ;
− un client de messagerie instantanée ;
− un lecteur multimédia et un afficheur de photo ;
− un client ń lŠAndroid Marketplace ż pour télécharger des applications dŠéditeur tiers ;
− un client pour la boutique dŠachat de musique ń Amazon ż.
Ces applications sont programmées en Java avec le SDK et sŠexécutent sur la Dalvik.

Mais

− Les données utilisées par toutes ces applications sont rendues disponibles aux
applications tierces.
− Les applications tierces peuvent recevoir et gérer des événements comme la

réception dŠappel téléphonique et celle de SMS.
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4 Ce quŠAndroid nŠest pas. . . 8

− une implémentation de Java ME, Micro Edition : une application android est écrite
en Java, mais ne sŠexécutent pas dans une machine virtuelle Java ME.
Les classes Java compilées et les exécutables ne peuvent tourner directement sous
android ;

− une partie du Linux Phone Standards Forum (LiPS) ou du Open Mobile Alliance
(OMA) : android tourne sur un noyau Linux opensource, mais lŠapproche dŠAndroid
est plus global ;

− juste une couche applicative : Android recouvre la pile logiciel complète :système
dŠexploitation, bibliothèques et les applications également ;

− un téléphone mobile : Android inclus un document de référence pour la conception
de téléphone, mais il nŠexiste pas ń un seul ż téléphone Android mais au contraire
de nombreux téléphones fabriqués par différents constructeurs ;

− la réponse de Google à lŠiPhone : Android est issu dŠun consortium et non dŠun seul
constructeur.
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5 Le terminal Android 9

CŠest un smartphone, caractérisé par :
⋄ un processeur autour de 1Ghz, comme le Snapdragon de Qual-

comm sur architecture ARM ;
⋄ une batterie de capacité limitée, 1 ou 2 journées dŠutilisation ;
⋄ un écran de résolution variable suivant les modèles limitée en

dimension, QVGA : 320x240, WVGA : 800x480, etc.
⋄ une mémoire intégrée importante : ∼ 512Mo de RAM, 512Mo

de Ćash ;
⋄ un espace de stockage renouvelable et extensible (SDCard) ;

⋄ écran tactile, capacitif ń multi-touch ż, ou encore résistif ;
⋄ capacités multimédia 2D, 3D, vidéo et son : différents CODECs : MPEG4,

H.264, MP3, AAC, AMR, JPG, PNG, GIF, différentes APIs : OpenGL, Free-
Type, SGL ;

⋄ lŠaccès à Internet en mobilité : accès au WiFi, au GSM, au EDGE, à la 3G pour
la téléphonie et lŠéchange de données ;

⋄ un environnement de développement riche, basé sur le langage Java permettant
de créer facilement des applications mobiles connectées !
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6 Notre terminal Android 10
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??
7 Les avantages de la plateforme Android et de ses APIs 11

− pas de license à obtenir, pas de dépense pour la distribution et le développement
Cool pour lŠUniversité !
− développer des applications ń location-based ż en utilisant le GPS ;
− utiliser des cartes géographiques avec Google Maps ;
− recevoir et émettre des SMS, envoyer et recevoir des données sur le réseau mobile ;
− enregistrer et lire image, son et vidéo ;
− utiliser compas, accéléromètre, gyroscope ;
− des IPC, inter process communication, avec les NotiĄcations et Intents pour une

relation ń event-driven ż avec lŠutilisateur et lŠéchange de messages entre applis ;
− desoutils de stockage de données partagés (SQLite en version Sandbox) ;
− Content Provider pour partager lŠaccès à ses données ;
− un navigateur que lŠon peut inclure basé sur WebKit ;
− une accélération matérielle pour la 2D et la 3D ;
− des services et des applications qui peuvent tourner en tâche de fond : qui peuvent

réagir au cours dŠune action, à votre position dans la ville, à lŠheure quŠil est, suivant
lŠidentité de lŠappelant. . .
− une plateforme de développement qui favorise la réutilisation de composants logi-

ciels et le remplacement des applications fournies.
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8 La pile logicielle 12
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9 Modèle de sécurité 13

Chaque application Android est associée à un compte utilisateur Linux différent.

ANDROID PLATFORM SECURITY MODEL

Android Application #1

“DroidWars” 

com.androidbook.DroidWars

DALVIK Virtual Machine

Android Application #2

“Chippy’s Revenge!” 

com.androidbook.Chipmunk

DALVIK Virtual Machine

Linux User

“com.androidbook.DroidWars”

Private 

App Files and 

Databases

Linux User

“com.androidbook.Chipmunk”

Access Handset Hardware

Phone Dialer, WiFi, Bluetooth, Camera, Audio, 

Telephony, Device Sensors, etc.

Access Shared Data

Contacts, Calendars, Owner Information, 

Phone Data, etc.

Private 

App Files and 

Databases

Linux Operating System

Android Platform Security Enforcement

Le partage dŠaccès se fait ensuite suivant un système de ń permissions ż.
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10 Une application Android 14

Une application Android est constituée de composants faiblement couplés.
Ces composants sont décrits dans un même document : le ń manifest ż, un Ąchier au
format XML AndroidManifest.xml qui décrit :
− chaque composant : Activities, Services, Content Providers, Broadcast Receivers ;
− les interactions de ces composants : Intent Filters et NotiĄcations ;
− les accès nécessaires au matériel et logiciel (bibliothèques) :Permissions ;

Les composants pour déĄnir une application :
− les ń Activités ż ou activity : correspondent à des applications sur un ordinateur de

bureau.
⋄ elles sont démarrées à la demande de lŠutilisateur ou du système ;
⋄ elles tournent aussi longtemps quŠelles sont utiles : le système peut tuer une

activité pour récupérer de la mémoire ;
⋄ elles peuvent interagir avec lŠutilisateur, demander des données ou des services à

dŠautres activités ou à des ń services ż, au travers de requêtes et dŠń intentions ż,
intents ;

⋄ en général, une activité = un écran dŠinterface, appelé View.
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10.1 Une application Android 15

− les ń Services ż : similaires aux ń démons ż sous Unix et aux ń services ż sous Win-
dows : du code tournant en tâche de fond.
⋄ ils travaillent même lorsque lorsque lŠactivité de lŠapplication nŠest plus active

ou visible (par exemple, un lecteur MP3 qui peut jouer de la musique même si
lŠinterface de contrôle ne tourne plus) ;

⋄ ils peuvent transmettre des notiĄcations.

− les ń notiĄcations ż : cŠest un moyen de signaler à lŠutilisateur sans interrompre
lŠactivité courante, ni prendre le focus.
⋄ la meilleur méthode pour attirer lŠattention de lŠutilisateur depuis un service ou

un récepteur de diffusion ;
⋄ exemple : lŠutilisateur reçoit un SMS ou un appel et il est alerté par des voyants

qui clignotent, lŠécoute dŠun son, lŠaffichage du message ou une icone.
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10.2 Une application Android 16

− les ń fournisseurs de contenu ż ou Content providers :
ils ont été déĄnis pour partager des données avec dŠautres applications.
⋄ ils utilisent une interface standardisée sous la forme dŠURI, Uniform Resource

IdentiĄer, pour répondre à des requêtes en provenance dŠautres applications.
Ces applications nŠont même pas besoin de connaitre le fournisseur de contenu
qui leur répond.

⋄ exemple : content://contacts/people permet de déĄnir une requête pour
lŠaccès à la liste des contacts de lŠutilisateur ;
⋆ le système dŠexploitation recherche si une application sŠest enregistrée comme

fournisseur de contenu pour cette URI ;
⋆ sŠil trouve une application, il la démarre si elle ne sŠexécute pas déjà, et lui

transmet la requête ;
⋆ sŠil trouve plus dŠune application, il demande à lŠutilisateur laquelle il veut

utiliser.
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10.3 Une application Android 17

− les ń intents ż ou notiĄcations : ils déĄnissent un modèle par ń passage de message ż
entre les applications.
⋄ Ces messages peuvent être diffusés, broadcast, à tout le système ou bien être

envoyés à une activité ou un service particulier (le système décide des cibles) ;
⋄ un message a pour but de déclencher une action.

− les ń récepteurs de diffusion ż, ou broadcast receivers. Ils sŠenregistrent dans le
système et reçoivent les messages diffusés qui correspondent à un Ąltre prédéĄni.
⋄ ils peuvent déclencher une application en réponse à la réception dŠun message ;
⋄ ils permettent dŠutiliser un modèle ń piloté par les événements ż, event-driven.

− les ń widgets ż : des composants visuels qui peuvent être ajoutés à lŠécran de dé-
marrage, home screen. Il correspondent à une variation du broadcast receiver.

LŠintérêt de ces composants est de permettre de les partager avec dŠautres applications
(en particulier les services et fournisseurs de contenu).
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11 Cycle de vie dŠune ń activity ż 18

Dans Android, il nŠy a quŠune activité ń active ż à la fois, c-à-d. en ń avant-plan ż ou
foreground.

Le système dŠexploitation est libre de terminer une activité qui est en arrière-plan,
lorsque la quantité de mémoire libre du système est trop basse.

Ainsi, une application Android, lorsquŠelle nŠest plus en avant-plan, doit être capable de
maintenir son état pour garantir un fonctionnement seamless à lŠutilisateur (retrouver
les valeurs et affichage précédents lorsquŠil remet lŠapplication en avant-plan).

CŠest à lŠapplication de gérer son état, ses données, et ses ressources aĄn dŠêtre prête
à être interrompue ou bien terminée à tout moment.

Pour répondre à ses événements, des méthodes de réponse, callback, sont déĄnies :
onCreate(), onResume(), onPause(), onDestroy()
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11.1 Cycle de vie dŠune ń activity ż 19

Description des différents callback et des actions à entreprendre lors de leur réception :
− onCreate() : est appelé quand lŠapplication démarre ou redémarre.

Initialiser les données statiques, établir des liens vers les données et les ressources,
positionner lŠinterface avec setContentView().
− onResume() : appelé quant une activité passe en avant-plan.

Reprendre le contrôle des ressources exclusives.
Continuer les lectures audio et vidéo ou les animations.
− onPause() : appelé quand lŠactivité quitte lŠavant plan.

Sauvegarder les données non encore sauvegardées, libérer lŠaccès aux ressources
exclusives, stopper la lecture audio, vidéo et les animations.
− onDestroy() : appelé quand lŠapplication est fermée.

Nettoyer les données statiques de lŠactivité, libérer toutes les ressources obtenues.
Il est nécessaire de limiter le temps pris pour traiter la réception
de ces callbacks :
− la thread principale de lŠapplication est celle sŠoccupant de

lŠinterface :UI thread ;
− elle ne doit pas être bloquée plus de 5 secondes sous peine de

voir le ń Application Not Responding ż.
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11.2 Cycle de vie 20

onCreate()

onStart()

onResume()

onRestart()

onDestroy()

Activity 

Brought to 

Foreground

Activity Killed 

For Memory

Activity Sent 

To Background

Activity 

Brought to 

Foreground

Activity 

Brought to 

Foreground

Activity

Sent to 

Background

Request 

Activity

Start

Activity 

Running In

Foreground

onPause()

onStop()
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12 Installation de lŠenvironnement de développement 21

Pour pouvoir développer une application Android, on utilise :
− le kit de développement fourni par Google ;
− un des différents simulateurs de terminaux communicants.
Ces différents éléments peuvent être intégrés et utilisés dans lŠIDE, ń Integrated De-
velopment Environment ż, Eclipse.

Pour pouvoir utiliser lŠAPI Bluetooth sur le simulateur, on utilise une bibliothèque per-
mettant de simuler son fonctionnement en utilisant la pile de communication TCP/IP
de la machine hôte.
En effet, le simulateur ne prends pas en charge la présence éventuelle dŠun composant
bluetooth sur la machine hôte.

Pour cela, on va installer :
− Eclipse ;
− le SDK dŠAndroid ;
− une bibliothèque pour lŠutilisation du Bluetooth ;
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12.1 Installation de lŠIDE Eclipse 22

Sous Ubuntu, on peut utiliser le
gestionnaire de paquets Synaptic :

On sélectionne Eclipse, pour procéder à
son installation.

On peut également utiliser la commande :

$ sudo apt-get install eclipse
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12.2 Récupération du SDK Android 23

Le SDK dŠAndroid est disponible à lŠadresse :
http://developer.android.com/sdk/index.html

On choisira lŠarchive android-sdk_r06-linux_86.tgz.
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12.3 Installation du SDK et intégration dans Eclipse 24

− récupérer lŠarchive android-sdk_r06-linux_86.tgz

− créer un répertoire ANDROID :

$ mkdir ~/ANDROID

$ tar xvfz android-sdk_r06-linux_86.tgz

$ cd android-sdk-linux_86

Il faut ajouter la ligne
export PATH=${PATH}:${HOME}/ANDROID/android-sdk-linux_86/tools

à la Ąn du Ąchier ~/.bashrc, pour lŠaccès aux commandes du SDK.
− il faut ajouter le plugin ń Android Developement Tools (ADT) ż dans Eclipse :
⋄ Allez dans le menu ń Help → install new software ż, et rajoutez le site

https://dl-ssl.google.com/android/eclipse/

⋄ sélectionnez les ń Developper Tools ż ;
⋄ acceptez lŠinstallation dŠéléments non signés.
− Allez dans le menu ń Window → Preferences ż :
⋄ sélectionnez ń Android ż ;
⋄ indiquez dans le zone de saisie le chemin dŠaccès au SDK :

/home/pef/ANDROID/android-sdk-linux_86/

Vous mettrez votre nom de compte à la place de ń pef ż. . .
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12.4 Récupération de la plate-forme Android 25

− Allez dans le menu ń Window → Android SDK and AVD Manager ż :
⋄ sélectionnez la plate-forme 2.2
⋄ vous pouvez retourner dans le menu ń Window→ Preferences ż pour vériĄer la

présence de cette plate-forme.

− installer une bibliothèque pour lŠutilisation du Bluetooth :
http://github.com/cheng81/Android-Bluetooth-Simulator

$ sudo apt-get install git-core

$ cd ANDROID

$ git clone git://github.com/cheng81/Android-Bluetooth-Simulator.git

$ cd Android-Bluetooth-Simulator



T
M

C

13 Le contenu du SDK 26

− les APIs Android ;
− les outils de développement (dans le répertoire tools) :
⋄ DDMS, Dalvik Debug Monitoring Service : le débogueur ;
⋄ AAPT, Android Asset Packaging Tool : outil de construction des packages

dŠapplication (.apk) ;
⋄ ADB, Android Debug Bridge : copier des Ąchiers, déployer des applications ;
⋄ SQLite3 : pour la gestion des BDs ;
⋄ MkSDCard : pour créer une SDCard virtuelle ;
⋄ dx : convertir les .class Java en bytecode Android .dex.
− lŠémulateur android :
⋄ interactif, avec possibilité de simuler la gestion dŠappel téléphonique et de SMS ;
⋄ plusieurs skins pour tester différents form factors (écran, orientation, etc.) ;
⋄ chaque application est exécutée dans une VM Dalvik, ce qui permet de tester

et de déboguer les applications dans un environnement ń réel ż.
− une documentation : http://developer.android.com/guide/index.html

− une communauté de développeur :
http://developer.android.com/resources/community-groups.html

et sur Stack OverĆow : http://stackoverflow.com/

− des exemples de code.
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Allez dans le menu ń Window → Android SDK and AVD Manager ż, puis prendre
ń Virtual Devices ż (avec les choix par défaut) :
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Il est possible de se connecter au terminal virtuel à lŠaide de la commande telnet sur
le port indiqué dans le nom de la fenêtre de lŠémulateur :
pef@pef-desktop:~/ANDROID/android-sdk-linux_86/tools$ telnet localhost 5554

Trying 127.0.0.1...

Connected to localhost.

Escape character is ’^]’.

Android Console: type ’help’ for a list of commands

OK

help

Android console command help:

help|h|? print a list of commands

event simulate hardware events

geo Geo-location commands

gsm GSM related commands

kill kill the emulator instance

network manage network settings

power power related commands

quit|exit quit control session

redir manage port redirections

sms SMS related commands

avd manager virtual device state

window manage emulator window

try ’help <command>’ for command-specific help

OK
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Puis on déĄnit les options ⇒
de lŠapplication :
⋄ Package Name ;
⋄ Activity ;
⋄ Application name ;
⋄ la version de la plateforme.

⇐On choisit le menu ń File → New → Project ż
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On obtient le code ci-dessous dans le Ąchier HelloWorld.java :

package edu.cryptis.tmc.helloworld;

import android.app.Activity;

import android.os.Bundle;

public class HelloWorld extends Activity {

/** Called when the activity is first created. */

@Override

public void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);

setContentView(R.layout.main);

}

}

Ce code :
− déĄnit une activity, par héritage de la classe Activity ;
− positionne son interface utilisateur par lŠutilisation de setContentView().
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Menu ń Project→Properties ż, vériĄez que :
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Elle est déĄnie par :
− lŠutilisation dŠun container vertical qui remplit tout lŠécran
⋄ qui contient une étiquette faisant référence au contenu dŠune chaîne déĄnie

dans les ressources (répertoire res/).
<?xml version="1.0" encoding="utf-8"?>

<LinearLayout xmlns:android="http://schemas.android.com/apk/res/android"

android:orientation="vertical"

android:layout_width="fill_parent"

android:layout_height="fill_parent"

>

<TextView

android:layout_width="fill_parent"

android:layout_height="wrap_content"

android:text="@string/hello"

/>

</LinearLayout>

et celui du fichier res/values/strings.xml :
<?xml version="1.0" encoding="utf-8"?>

<resources>

<string name="hello">Hello World, HelloWorld!</string>

<string name="app_name">Hello World</string>

</resources>
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Le contenu du Ąchier res/layout/main.xml :

<?xml version="1.0" encoding="utf-8"?>

<manifest xmlns:android="http://schemas.android.com/apk/res/android"

package="edu.cryptis.tmc.helloworld"

android:versionCode="1"

android:versionName="1.0">

<application android:icon="@drawable/icon" android:label="@string/app_name">

<activity android:name=".HelloWorld"

android:label="@string/app_name">

<intent-filter>

<action android:name="android.intent.action.MAIN" />

<category android:name="android.intent.category.LAUNCHER" />

</intent-filter>

</activity>

</application>

</manifest>
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Un namespace est déĄnie xmlns:android qui est uniquement utilisé pour les attri-
buts du Ąchier XML et non pour les éléments, avec lŠexception de lŠattribut package

de lŠélément manifest. . .

DŠautres éléments :
− uses-permissions : les permissions nécessaires à lŠapplication ;
− permission : déclarer des permissions nécessaires aux autres applications dans le

but dŠavoir accès au données de lŠapplication ;
− instrumentation : indiquer le code à appeler lors de la réception dŠévénements

systèmes comme le lancement dŠune activité, pour monitoring ou du logging ;
− uses-library : utiliser dŠautres composants, comme le service de localisation ;
− uses-sdk : <uses-sdk minSdkVersion="2"/> pour des sous-versions du SDK ;
− application : déĄnir lŠapplication elle-même.
<manifest xmlns:android="http://schemas.android.com/apk/res/android"

package="edu.cryptis.tmc.monappli">

<uses-permission

android:name="android.permission.ACCESS_LOCATION" />

<uses-permission android:name="android.permission.ACCESS_GPS" />

<uses-permission android:name="android.permission.BLUETOOTH" />

<uses-permission

<application> ... </application>

</manifest>
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Il est possible pour déĄnir le contenu du Ąchier AndroidManifest.xml dŠutilisé
lŠéditeur spécialisé fourni par Eclipse :
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Par exemple pour rajouter une permission :



T
M

C

22 Application Android : différents Ąchiers et répertoires 37

− AndroidManifest.xml ;
− R.java : contient les références, ń ID ż, à différents éléments de lŠapplication ;
− build.xml et default.properties : utilisé par Ant ;
− bin/ : contient lŠapplication une fois compilée ;
⋄ bin/classes/ : les classes Java compilées ;
⋄ bin/classes.dex : lŠexécutable créé à partir de ces classes ;
⋄ bin/appli.ap_ : contient les ressources de lŠapplication en Ąchier Zip ;
⋄ bin/appli-debug.apk ou bin/appli-unsigned.apk : lŠapplication Android ;

Ce Ąchier .apk est signé électroniquement par une clé avec jarsigner.
− libs/ : les bibliothèques tierces nécessaires à lŠapplication ;
− assets/ : les Ąchiers multimédias et autres Ąchiers nécessaires à lŠapplication ;
− src/ : les sources de lŠapplication ;
− res/ pour les ressources :
⋄ res/layout/ : les Ąchiers au format XML pour déĄnir lŠinterface.
⋄ res/drawable/ : les Ąchiers images pour lŠinterface ;
⋄ res/menu/ : Ąchier de déĄnition en XML des menus ;
⋄ res/values/ : pour les chaînes de caractères, les constantes (permet de faci-

lement internationaliser une application) ;
⋄ res/xml/ : pour des Ąchiers au format XML.
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Pour ajouter un Ąchier de nŠimporte quel type à lŠapplication :
− le mettre dans le répertoire res/raw ;
− synchroniser lŠIDE Eclipse :
⋄ dans le menu contextuel du répertoire sélectionner lŠoption refresh ;
⋄ lŠIDE va créer les références manquantes dans le Ąchier R.java.

Attention

Chaque Ąchier doit avoir un nom unique en excluant son extension : toto.jpg
et toto.dat vont entrer en conĆit.

Pour référencer une ressource

Il faut utiliser la méthode getResources().openRawResource(R.raw.ma_ressource);

où ma_ressource correspond au nom du Ąchier.
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Il est possible de disposer dŠun système de gestion de préférences dont lŠaccès est
partagé entre les différents éléments constituants lŠapplication.
Pour accéder aux préférences, on utilisera la méthode getSharedPreferences().

Ces préférences sont organisées sous forme dŠobjet de la classe SharedPreferences

et chacun de ces objets peut recevoir un nom.
Ensuite, pour un de ces objets on peut déĄnir un ensemble dŠassociations de type
(clé, valeur).

1 SharedPreferences reglages = getSharedPreferences(“MesPrefs”, MODE_PRIVATE);

2 SharedPreferences.Editor editeurPref = reglages.edit();

3 editeurPref.putString(“Nom”, “toto”);

4 editeurPref.putBoolean(“Inscrit”, true);

5 editeurPref.commit();

Pour récupérer les valeurs de ces préférences :
1 SharedPreferences reglages = getSharedPreferences(“MesPrefs”, MODE_PRIVATE);

2 String nom = reglages.getString(“Nom”, “Titi”);

Dans la ligne 2, le deuxième argument de la méthode getString est la valeur à
retourner dans le cas où il nŠy aurait pas de valeur associée à la clé ń Nom ż.
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Nommer lŠapplication

On ajoutera dans le manifest :
1 <application android:label="Le nom de mon application">

Ou en faisant appel à une ressource :
1 <application android:label="@string/app_name">

LŠapplication portera comme nom, le contenu de la chaîne appelée app_name et déĄnie
dans le Ąchier strings.xml

Associer une icone à lŠapplication

On ajoutera dans le manifest :
1 <application android:icon="@drawable/mon_icone">

Pour déĄnir lŠicone, il faut :
− déĄnir cette icone au format PNG suivant 3 tailles différentes : 36x36, 48x48 et

72x72 suivant la densité de lŠécran qui peut être basse, moyenne ou grande ;
− stocker la version 36x36 dans res/drawable-ldpi/ sous le nom mon_icone.png

− stocker la version 48x48 dans res/drawable-mdpi/ sous le nom mon_icone.png

− stocker la version 72x72 dans res/drawable-hdpi/ sous le nom mon_icone.png

Android choisira automatiquement la taille la mieux adaptée.
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Fournir une description de lŠapplication

Cette description peut être utilisée dans le MarketPlace :
1 <application android:label="le nom de l’application"

2 android:description="@string/app_desc">

Pour déboguer lŠapplication

Pour pouvoir déboguer lŠapplication dans Eclipse, il est nécessaire dŠajouter lŠattribut
android:debuggable="true" dans lŠélément application dans le manifest.
Lors de la diffusion de lŠapplication, cet attribut doit être modiĄé.
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Android déĄnit la classe android.util.Log et les méthodes suivantes :
− Log.e()

− Log.w()

− Log.i()

− Log.d()

− Log.v()

Logs errors
Logs warnings
Logs messages de description
Logs messages de déboguage
Logs messages détaillés

Chaque message de déboguage doit être étiquetté avec un TAG :
1 private static final String TAG = "MonApplication";

2 . . .

3 Log.i(TAG, "Dans la methode Truc()");

Le TAG permet ensuite de Ąltrer au niveau du débogueur, LogCat dŠEclipse, les
messages que lŠon veut suivre.
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À qui cela correspond ?

Une application Android est constituée de composants logiciels faiblement couplés
qui correspondent chacune à une activité indépendante.
Parmi ces activités, lŠune est plus importante que les autres : elle apparait dans le
ń launcher ż.
On utilise un message, un intent pour demander au système de déclencher une activité.
Cette ń intention ż peut être plus ou moins spéciĄque, ce qui laisse une plus grande
liberté pour le choix de ou des activités qui vont la satisfaire.

Analogie avec le Web

Une analogie existe avec le protocole HTTP : un verbe + URL vers une ressource
(page web, image, programme serveur). Le verbe correspond à GET, POST etc.

Un intent représente une action + un contexte et il existe plus dŠactions et plus de
composants pour les réaliser.
À la manière du navigateur web qui sait traiter le verbe+URL, Android sait trouver
lŠactivité correspondante.
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Intent action + données
Données les données sont indiquées sous forme dŠune URI, comme

content://contacts/people/1

Action les actions sont des constantes, comme ACTION_VIEW

qui déclenche une visionneuse, ACTION_EDIT pour édi-
ter une ressource, ACTION_PICK pour sélectionner un élé-
ment suivant une URI représentant une collection comme
content://contacts/people.

Si on crée un intent avec lŠaction ACTION_VIEW et lŠURI content://contacts/people/1 :
Android va chercher et ouvrir une activité capable dŠafficher cette ressource.
DŠautres critères peuvent être ajoutés dans lŠintent

categorie lŠactivité principale sera dans la catégorie LAUNCHER, mais les
autres activités seront dans DEFAULT ou ALTERNATIVE.

type MIME pour indiquer le type de ressources sur lequel lŠaction va être
faite

un component pour indiquer la classe de lŠactivité qui est supposée recevoir
lŠintent. Réduit la portée de lŠintent mais permet de simpliĄer le
contenu de lŠintent.

Extras permet dŠajouter des données à transmettre au récepteur.
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On indique quels sont les intents attendus par un composant dans le Ąchier manifest,
à lŠaide dŠintent-filter :

1 <manifest xmlns:android="http://schemas.android.com/apk/res/android"

2 package="com.commonsware.android.skeleton"> <application>

3 <activity android:name=".GO" android:label="Go">

4 <intent-filter>

5 <action android:name="android.intent.action.MAIN" />

6 <category android:name="android.intent.category.LAUNCHER" />

7 </intent-filter>

8 </activity> </application></manifest>

Rendre plus spéciĄque le récepteur

Lorsque le système génère des événements, il est possible de déclencher :
− un service plutôt quŠune activité ;
− une activité suivant un contexte spéciĄque : le même intent sur une certaine donnée

déclenche une activité mais sur une autre donnée déclenche une autre activité.
On utilise des récepteurs dŠintent implémentant lŠinterface BroadcastReceiver.
Ces récepteurs sont des objets qui reçoivent des intents, surtout diffusés en broad-
cast, et qui réagissent en envoyant dŠautres intents pour déclencher une activité, un
service. . .
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Elle est constituée de seulement une méthode :onReceive().
Les objets implémentants cette interface doivent être déclarés dans le manifest :

1 <receiver android:name=".MaClasseRecepteur" />

Cet objet nŠest exécuté que jusquŠau retour de la méthode et sera enlever du
système : ils ne peuvent attendre de callback (pas dŠouverture de dialog par exemple).

Exception de traitement

Si on veut que le récepteur soit attaché à un composant logiciel avec une durée de
vie plus longue, comme celle du système :
− il ne faut pas déclarer le récepteur dans le manifest ;
− il faut enregistrer le récepteur à lŠaide de la méthode registerReceiver() lors

du callback onResume() de lŠactivité ;
− il faut dé-enregistrer le récepteur à lŠaide de la méthode unregisterReceiver()

lors du callback onPause() de lŠactivité ou lorsque lŠon ne désire plus recevoir
dŠintent associé.

Attention

LŠutilisation dŠobjet Intent pour passer des données quelconques nŠest possible
que si le récepteur est actif (possibilité de manquer des intents quand inactif).



T
M

C

30 LŠinterface graphique 47

Il existe deux manières de déĄnir une interface graphique :
− à lŠaide de Ąchier de description rédigé suivant le format XML
⋄ avantages : simplicité de conception, indépendance avec le code Java ;
⋄ inconvénients : déĄnition statique qui ne peut évoluer au cours de la vie de

lŠapplication ;
− avec du code Java
⋄ avantages : peut évoluer de manière dynamique durant la vie de lŠapplication

(exemple : déĄnir le contenu dŠun menu permettant de choisir un élément parmi
une liste construite par lŠapplication) ;

⋄ inconvénients : difficultés dŠorganisation, le code est mélangé à celui de
lŠapplication.

− tiré parti des deux. . .
− et aussi, utiliser une interface au format HTML avec le widget basé sur WebKit
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Les Ąchiers au format XML :
− sont stockés en tant que ressource dans : res/layout ;
− déĄnissent une hiérarchie entre les widgets :
⋄ un arbre dŠéléments de widgets et de containers ;
⋄ les attributs de ces éléments déĄnissent les propriétés :
⋆ lŠaspect dŠun widget comme celui dŠun bouton avec textStyle="bold"

⋆ le comportement dŠun container.
⋄ lŠoutil aapt parse ces Ąchiers et construit le Ąchier R.java contenant des réfé-

rences pour désigner un widget dans le code de lŠapplication.
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Il est possible dŠutiliser lŠéditeur intégré dans Eclipse :
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Ce Ąchier déĄnie une arborescence :
<?xml version="1.0" encoding="utf-8"?>

<LinearLayout xmlns:android="http://schemas.android.com/apk/res/android"

android:orientation="vertical"

android:layout_width="fill_parent"

android:layout_height="fill_parent"

>

<TextView

android:layout_width="fill_parent"

android:layout_height="wrap_content"

android:text="@string/hello"

/>

<Button android:text="@+id/Button01" android:id="@+id/Button01"

android:layout_width="wrap_content" android:layout_height="wrap_content">

</Button>

</LinearLayout>

Sur cet exemple, les widget :
− sont de la classe Button et TextView qui héritent de la classe android.view.View ;
− disposent d’un identifiant avec l’attribut android:id ;
− affichent à l’initialisation le texte qui est définie par l’attribut android:text.

Pour le TextView on remarque qu’il fait référence à une chaîne définie dans le fichier strings.xml

et référencée par "@string/hello.
− les attributs android:layout_width et android:layout_height sont définis à fill_parent ;
À Quoi correspondent les « @ » ? À définir une identité pour une référence ultérieure : « @+id/mon_id »
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Le Ąchier R.java contient des références sur les éléments de lŠinterface :
1 /* AUTO-GENERATED FILE. DO NOT MODIFY.

2 *

3 * This class was automatically generated by the

4 * aapt tool from the resource data it found. It

5 * should not be modified by hand.

6 */

7 package edu.unilim.helloworld;

8 public final class R {

9 . . .

10 public static final class layout {

11 public static final int main=0x7f030000;

12 }

13 public static final class id {

14 public static final int Button01=0x7f050000;

15 }

16 }

− la méthode setContentView permet dŠappeler lŠinterface déĄnie dans un Ąchier XML :
setContentView(R.layout.main)

− on utilise la méthode findViewById() à laquelle on passe lŠidentiĄant numérique déĄni dans le Ąchier
R.java.
Exemple : Button btn = (Button) findViewById(R.id.button01)

On utilise le nom déĄnie dans le Ąchier XML dŠinterface, ici ń button01 ż.
− on accroche un listener : btn.setOnClickListener(. . . ) pour obtenir lŠévénement (clic du bouton).
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Il existe différentes classes et sous-classes :
− ImageView : avec les attributs android:src, comme par exemple : android:src="@drawable/logo"

Il est également possible d’utiliser la méthode setImageURI() pour utiliser un Content

Provider

− ImageButton

− EditText : pour une zone de saisie. Avec les attributs :
⋄ android:numeric pour ne rentrer que des chiffres ;
⋄ android:singleLine="false" pour indiquer si la saisie se réalise sur une ligne ou plus ;
⋄ android:password : pour l’entrée masquée d’un mot de passe.
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Lorsque lŠon veut intéragir avec lŠutilisateur de manière rapide et simple, sans avoir à
créer une activité dédiée, on peut créer une fenêtre de Dialog :
− Activity.showDialog() : afficher un dialogue ;
− Activity.onCreateDialog() : une fonction de callback lors de la création du

dialogue et son ajout à la liste des autres dialogues de lŠactivité ;
− Activity.onPrepareDialog() : permet de mettre à jour un dialogue juste avant

son affichage ;
− Activity.dismissDialog() : ferme un dialogue et retourne à lŠactivité ;
− Activity.removeDialog() : supprime le dialogue de la liste des dialogues.

On peut déĄnir lŠapparence du dialogue à lŠaide :
− dŠun Ąchier layout au format XML ;
− la méthode setContentView().
Il existe des dialogues prédéĄnis : AlertDialog, CharacterPickerDialog, Date-

PickerDialog, ProgressDialog et TimePickerDialog.

On peut récupérer les références vers les éléments de lŠinterface à lŠaide de Dia-

log.findViewById().
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CŠest un message qui va venir en premier plan et disparaitre automatiquement après
un temps limité.

1 Context context = getApplicationContext();

2 CharSequence text = "Hello toast!";

3 int duration = Toast.LENGTH_SHORT;

5 Toast toast = Toast.makeText(context, text, duration);

6 toast.show();

Ou plus simplement :
1 Toast.makeText(context, text, duration).show();
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Avec Bluetooth, il est possible de :
− chercher dŠautres appareils, devices, à proximité ;
− établir une communication de type Ćux à lŠaide dŠune socket bluetooth.
Il existe 4 classes pour gérer le bluetooth :
− BluetoothAdapter : représente lŠinterface matérielle bluetooth, le bluetooth device

sur lequel tourne Android ;
− BluetoothDevice : représente chaque appareil distant avec lequel on peut com-

muniquer, remote bluetooth device ;
− BluetoothSocket : permet de déclencher une requête de connexion vers un appa-

reil distant et dŠétablir une communication ;
− BluetoothServerSocket : permet de déĄnir un serveur en attente de connexions

en provenance des appareils distants.
Pour accéder à lŠinterface bluetooth :

1 BluetoothAdapter bluetooth = BluetoothAdapter.getDefaultAdapter();

Il faut également les permissions suivantes dans le manifest :
1 <uses-permission android:name="android.permission.BLUETOOTH"/>

2 <uses-permission android:name="android.permission.BLUETOOTH_ADMIN"/>

1. pour déclencher une découverte du voisinage, discovery, établir des communications
2. pour modiĄer les propriétés de lŠinterface.
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Par défaut, lŠinterface Bluetooth nŠest pas activée pour économiser la batterie, et pour
des questions de sécurité.

Il est nécessaire de lŠactiver :
− soit avec la méthode enable(), si lŠon dispose de la permission BLUETOOTH_ADMIN ;
− soit à lŠaide dŠune sous-activité asynchrone dont on attendra le résultat :
1 String enableBT = BluetoothAdapter.ACTION_REQUEST_ENABLE;

2 startActivityForResult(new Intent(enableBT), 0);

LŠutilisateur sera prévenu et une demande dŠautorisation lui sera affichée.
Dans le premier cas, il vaut mieux prévenir lŠutilisateur de la mise en activité de
lŠinterface.
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LŠutilisation de Bluetooth se fait au travers dŠun service.
Pour obtenir une référence vers ce service, il faut utiliser la méthode getSystemSer-

vice de la classe Context qui permet dŠaccéder au système :
1 String nom_service = Context.BLUETOOTH_SERVICE;

2 BluetoothDevice bluetooth = (BluetoothDevice)getSystemService(nom_service);

LŠobjet BluetoothDevice

Ensuite, il est possible dŠutiliser les méthodes suivantes :
− enable et disable : activer ou désactiver lŠinterface ;
− getName et setName : pour manipuler le nom de lŠinterface (si elle est active) ;
− getAddress : pour obtenir lŠadresse de lŠinterface ;
− get/setMode et : pour conĄgurer le mode de découverte ń discoverable ż ou

ń connectable ż
− get/setDiscoverableTimeout : pour conĄgurer le temps utilisé pour cette dé-

couverte ;
1 bluetooth.setName(“YOBIBO”);

2 bluetooth.setMode(BluetoothDevice.MODE_DISCOVERABLE);
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Pour la découverte, discovery, des autres appareils bluetooth, il faut :
− être en mode découverte ;
− démarrer un cycle de découvrable :
⋄ bluetooth.startPeriodicDiscovery();

⋄ bluetooth.startDiscovery(true);

Ces deux méthodes sont asynchrones, et diffusent un intent RE-

MOTE_DEVICE_FOUND_ACTION à chaque découverte dŠun appareil bluetooth.
− obtenir la liste des appareils découverts : listRemoteDevices qui retourne un

tableau de chaîne de caractères, contenant les adresses de chacun de ces appareils ;
− obtenir le nom dŠun appareil : getRemoteName en donnant en paramètre lŠadresse

de lŠinterface.

Pour le pairing

Il faut utiliser les méthodes suivantes :
− createBonding : pour établir le lien (cancelBonding pour lŠabandonner) ;
− setPin : pour indiquer le PIN de sécurité à utiliser (cancelPin pour le redéĄnir).
Une fois un lien établie avec un appareil, ce lien est ajouté à la BD de lŠappareil et
sera utilisé de nouveau lors dŠune prochaine rencontre du même appareil.
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1 String[] devices = bluetooth.listRemoteDevices();

2 for (String device : devices) {

3 if (!bluetooth.hasBonding(device)) {

4 // Set the pairing PIN. In real life it’s probably a smart

5 // move to make this user enterable and dynamic.

6 bluetooth.setPin(device, new byte[] {1,2,3,4});

7 bluetooth.createBonding(device, new IBluetoothDeviceCallback.Stub() {

8 public void onCreateBondingResult(String address, int result) throws RemoteException{

9 if (result == BluetoothDevice.RESULT_SUCCESS) {

10 String connectText = “Connected to “ + bluetooth.getRemoteName(address);

11 Toast.makeText(getApplicationContext(), connectText, Toast.LENGTH_SHORT);

12 }

13 }

14 public void onEnableResult(int _result) throws RemoteException {}

15 });

16 }

17 }

Pour écouter les requêtes de pairing, il faut déĄnir un BroadcastListener Ąltrant
les intents ACTION_PAIRING_REQUEST.
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1 BroadcastReceiver discoveryMonitor = new BroadcastReceiver() {

2 String dStarted = BluetoothAdapter.ACTION_DISCOVERY_STARTED;

3 String dFinished = BluetoothAdapter.ACTION_DISCOVERY_FINISHED;

4 @Override

5 public void onReceive(Context context, Intent intent) {

6 if (dStarted.equals(intent.getAction())) {

7 // Discovery has started.

8 Toast.makeText(getApplicationContext(),

9 "Discovery Started...", Toast.LENGTH_SHORT).show();

10 }

11 else if (dFinished.equals(intent.getAction())) {

12 // Discovery has completed.

13 Toast.makeText(getApplicationContext(),

14 "Discovery Completed...", Toast.LENGTH_SHORT).show();

15 }

16 }

17 };

18 registerReceiver(discoveryMonitor, new IntentFilter(dStarted));

19 registerReceiver(discoveryMonitor, new IntentFilter(dFinished));
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Il faut modiĄer le Ąchier AndroidManifest.xml pour rajouter la permission dŠutiliser
lŠaccès à Internet (en plus de celle dŠaccès à bluetooth et à son administration) :

1 <uses-permission android:name="android.permission.INTERNET">

2 </uses-permission>

En effet, la simulation de bluetooth passe par lŠutilisation de la pile TCP/IP. . .
ModiĄcations du source de lŠapplication

Pour lŠaccès à la bibliothèque, il faut :
− changer lŠimportation :

import android.bluetooth⇒import dk.itu.android.bluetooth

− appeler BluetoothAdapter.SetContext(this); par exemple dans la méthode
onCreate() appelé lors de lŠinitialisation de lŠactivity.

Lancer le serveur de liaison

Dans Eclipse, il faut lancer btemu ou directement sur la ligne de commande :

$ java -jar btsim-server.jar

Server started on port 8199

ADB command: adb

press any key to exit

Ce serveur TCP/IP sŠoccupe de faire la liaison entre les différents AVDs.
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On peut faire appel aux fonctions de hashage MD5 et SHA1 :
1 // Obtain a message digest object.

2 MessageDigest md = MessageDigest.getInstance("MD5");

3 // Calculate the digest for the given bytes array

4 md.update(saisie.getText().toString().getBytes(), 0, saisie.length());

5 val_hash = new BigInteger(1,md.digest());

6 mon_texte.setText(String.format("%1$08X", val_hash));

Remarques :
− ligne 4 :
⋄ la variable saisie correspond à un widget de type EditText ;
⋄ dans la méthode getBytes(), il est possible dŠindiquer un encodage comme

"ISO-8859-1" ou "UTF-8" pour traduire les éventuels caractères accentués ;
− ligne 5 : on traduit la valeur retournée par la fonction de hashage en un entier de

taille variable, BigInteger ;
− ligne 6 : ce grand entier est ensuite affiché sous forme hexadécimal, puis affecté au

widget de type TextView appelé mon_texte.
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1 // Get an instance of the RSA key generator

2 KeyPairGenerator kpg = KeyPairGenerator.getInstance("RSA");

3 // Generate the keys — might take sometime on slow computers

4 KeyPair myPair = kpg.generateKeyPair();
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Il est possible de récupérer des clés RSA à lŠintérieur dŠune application Android :
− les convertir dans une représentation DER, c-à-d. en notation ASN.1 ;
− placer les Ąchiers les contenant dans le répertoire res/raw ;
− utiliser la méthode getResources() pour obtenir des références vers ces Ąchiers ;
− utiliser la classe KeyFactory pour importer les clés.

1 KeyFactory kf = KeyFactory.getInstance("RSA");

2 InputStream fic_cle = getResources().openRawResource(R.raw.ma_cle_publique);

3 byte[] cle_pub_asn1 = new byte[fic_cle.available()];

4 fic_cle.read(cle_pub_asn1);

5 fic_cle.close();

6 X509EncodedKeySpec cle_pub = new X509EncodedKeySpec(cle_pub_asn1);

7 kf.generatePublic(cle_pub);

9 fic_cle = getResources().openRawResource(R.raw.ma_cle_privee);

10 byte[] cle_priv_asn1 = new byte[fic_cle.available()];

11 fic_cle.read(cle_priv_asn1);

12 fic_cle.close();

13 PKCS8EncodedKeySpec cle_privee = new PKCS8EncodedKeySpec(cle_priv_asn1);

14 kf.generatePrivate(cle_privee);


